
By Nick Klein 

 

When a new version of CAMAvision is released, our support staff appreciates an 
updated computer information report from each client.  This report is generated 
automatically with the update program but a user can create one at any time.  It can be 
found on the Help menu > Computer Info Report.  The report shows what CAMAvision 
modules are installed, network license counts, as well as calculation settings used by 
CAMAvision.   

Additionally the report shows some geeky info about computer hardware which we’ve 
used for troubleshooting and development planning.  A few noteworthy items include the 
version of Windows, the number of monitors, and screen resolutions.  

Windows 7 leads with the most number of installations of our clients, followed by 
Windows XP.  The rest are servers, Vista and Windows 8.  Since we started collecting 
this information with CAMAvision v17, we’ve been observing a slow but steady decline 
in the use of XP.  This makes sense because Microsoft has been trumpeting the end of 
support for XP for some time – I even wrote about it in the last newsletter. 

The monitor count on the computer information report is interesting to me because right 
now it’s about a 50 – 50 split between computers with a single monitor and two 
monitors.  Since users have to wear many hats to do their job: running combinations of 
appraisal, tax, mapping, and imagery software, it’s not surprising to see the monitor 
count rising over the last couple years.  I think the day is coming, not too far in the 
future, when we’ll see multiple monitor setups surpass the single monitor workstation.  
As of this writing, we know of over two dozen computers using three monitors, and even 
a few using four!   

A couple other pieces of information about the computer screens that we’re monitoring 
(no pun intended) are resolution and font sizes.  These numbers vary greatly depending 
on the size of the screens and use of the computer.  For instance, if a workstation 
routinely runs a mapping program like ArcGIS, it’s more likely to have a higher screen 
resolution than a workstation used just for data entry.  However the screen resolution 
and font DPI are two pieces of information that can greatly influence the direction of 
CAMAvision development.  Case in point: We still have a small number of users 
continuing to use the screen resolution 800 x 600.  This is the minimum screen 
resolution supported for Windows 7 and for CAMAvision.  I’ve gotten many questions 
about the “empty space” on some screens in the program.  These spaces are not so empty 
when running at the lowest resolution.   

Just as monitors on the desktop have started to get bigger, more and more users are 
adding a tablet computer to their list of hardware.  Naturally these screens can be quite 
small: 7 to 10 inches at most.  We’ll be taking what we learn from these computer 
information reports and continue to adapt CAMAvision to work in ways that are best for 
all our users. 

What are you using to run CAMAvision®? 
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The Pure Awesomeness of Income 
By:  Patrick Alexander 

Coming in version 18.5 this summer, the income module will have a plethora of improvements all geared to 
make your work life more rewarding and fulfilling. Not sure a change in software can have such a profound 
affect in your day-to-day work? Well allow us to blow your mind once more, as we continue to increase its level 
of awesomeness. 

The first enhancement out of the gate is the ability to track the square footage for non-per/SF priced income 
lines. No longer will you need to sit and wonder just how big those two bedroom apartments are just because 
you are pricing per/unit. Simply enter the square footage as a description and the mystery is solved! 

Not content with only five rates per income and/or expense line? We understand your pain and have increased 
the number of rates available to nine. Want to note something specific about a line you are working on, but not 
all that keen on hunting for it within the statement comment? No problem. We now have a comment on each 
line. Document to your heart’s content! 

Have you forgotten to enter that pesky unit quantity of one and had an income line fail to calculate? Have no 
fear, for CAMAvision is here! Another new feature we have added is the ability to default the units to one when 
the income line has a square footage entered and is being priced per/SF. 

Have some statements where the land is worth more than the income it is producing? I think you will be excited 
by our final slice of awesomeness in this release. It is the ability to attach a piece of land via cost links, but have 
the statement calculate its value without breaking out the land in its own bucket. This will allow the cost 
approach value for the land to stay independent of the income approach valuation. 

I am sure you are all thinking, this is just too much awesome to handle for one release! I know, but let me be 
the first to tease you … in version 19 (slated for later this year) an even bigger change is coming. But for now 
you’ll have to enjoy the slice of awesome that you have in front of you. 
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By:  Sherry Surrett 

This year marks the first year for the Missouri homeowners to submit their Personal Property Reporting Forms 
online through the client’s Vanguard Personal Property Website.  We had three jurisdictions who gracefully 
volunteered to try this process. 

A special thanks needs to go to Tammy Mackey (Cass County) for all of her great suggestions and feedback that 
made the eFile what it is today. 

I also want to extend a huge thanks to Cass County and Vernon County for starting off the testing with a small 
subset of their accounts for first mailings. By the time second mailings rolled around, Warren County was on 
board as well.  All three jurisdictions sent out their second mailings with notification that filing electronically 
was now an option.   

During this trial phrase we: 

1)  Increased the speed of our internet lines to handle all additional traffic for e-Filing. 

2)    Worked with assessor’s office to develop a public friendly and smooth process for filing forms online. 

3)   Ran numerous test scenarios to ensure a smooth eFile processing experience.  

We are looking forward to next year when we can close the book on the trial phrase and open up eFile to all 
homeowners in these jurisdictions as well as the other five jurisdictions that have hopped on board.   

eFile Testing Is A Success 

Teresa
Typewritten Text
Back to Index

Teresa
Typewritten Text

Teresa
Typewritten Text



PAGE 3 VANGUARD APPRAISALS,  INC. SPRING 2014 

Did You Know... 
By: Mike Weeks 
 
Built into CAMAvision® is a Grain Bin Estimator. Simply click on the down arrow (combo box) to the right of 
the Change PIN icon within a parcel and you will find the Grain Bin Estimator. 
 

 
 
How many times have you been given the Bushel Capacity of a bin or the only information you have on old 
records are the bushels? By clicking this Estimator you can find the Height x Diameter possibilities of a Bin. 
You could also use this tool if you have only one of the variables height or diameter and bushels to find out 
grain bin size. 

In the below example, I have typed 10,000 Bushels +/- 3%. The Estimator has highlighted possible matches for 
me to consider. You also have the ability to apply the compaction factor adjustment as defined on page 1-13 of 
the Manual. 
 

  
 
This works similar to a multiplication table with the Diameter on the “X” axis across the top and the Height on 
the “Y” axis on the left.  The height and diameter are only an estimate related to the Bushels.  
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Comparable Search Within a Parcel: 
By: Mike Weeks 
 
At the 2013 User Group meetings, Nick showed us the ability to launch Comp Search from within a parcel. As 
many of you know Comp Search has been around since CAMAvision® became a windows based program in the 
early 1990’s. You can still find Comp Search in the Extra Modules menu but our programmers added the Icon 
within a parcel as shown below. 
 

 
 
What this tool does is use the selected parcel as the Subject. You still have the freedom to do an Equity Study 
as well as a Market Study.  
 
Comp Search also has a second Comp Search report. The difference between Comp Search Property Review 
and Comp Search Property Review #2 is that #2 lists the Subject and comparables next to each other rather 
than each on a single sheet of paper. Also, don’t forget about the ability to print the Comp Search Grid. 
 

 
 
Simply click on the “Down Arrow” (combo box) to the right of Reports and click on “Print Grid.” This will show 
the basic information as well as the photo of the subject and the comparables the system found as well as any 
comparables you have added. 
 
Comp Search remains a powerful tool for your office to support values and gives you a lot of flexibility to defend 
your values. 

www.facebook.com/camavision
www.linkedin.com
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Microsoft has made some changes to the way data imports into Excel for the 2013 suite of MS Office. What does this mean 
for the CAMAvision user? If you do not have ProVersion, your method for opening exported queries will change for Excel 
2013. Do not fear. Just follow the steps outlined below to get up and running again.  

Note: Users with ProVersion already have the ability to export directly to Excel format and should not need to follow these 
steps. 

1. Exporting a Query 
a. Open a saved query or create one from scratch.  
b. Use the File menu (from the Preview tab) to Export 

 

c. Click the Ellipse button  

 

d. Choose a location (e.g. Desktop) 
e. Type a “File name” (see rules below for best results) 

i.  Maximum of 8 characters 
ii.     Letters/numbers only 
iii.    No special characters: spaces, underscores, hyphens, etc. 
iv.    Keep the “.dbf” at the end of the file name 

 

f. Click the “Save” button 

 
 

Query Exports for EXCEL 2013 
By: Danielle Powell 
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Query Exports for EXCEL 2013-Continued 
g. Verify the location and file name, and click “OK” 

 

h. The DBF file (and a DBT file, if legal included) appear on your desktop 

 

2. ODBC dBase Setup (this should only need done once if future query exports are saved to the same 
location).  

a. Open the “odbcad32.exe” file located in your C:/Windows/SysWOW64/ directory 
 

i. Open “Computer” 

 

ii. Open “OS (C:)” drive 

 

 

 

 

 

iii. Open “Windows” folder 
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Query Exports for EXCEL 2013-Continued 

iv. Open “SysWOW64” folder 

 

 

 

 

 

 
 

v. Double-click “odbcad32.exe” 
 

 

 

 

 

 

 

b. On the “User DSN” tab, click the “Add” button 

 

 

 

 

 

 

 
 

c. Select “Microsoft dBase Driver (*.dbf)” 
i. Press the “Finish” button 
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d. Type in the Data Source Name, “MS dBase Data Source” 
e. Uncheck the box for “Use Current Directory” 
f. Click on the “Select Directory” button 
 

 

 

 

 

 

 

i. “Folders” (right side): select the location of your DBF file (e.g. Desktop) 
ii. “File name” (left side): any DBF files (exported queries) currently located in the selected folder 

will appear in a list 
iii. Press the “OK” button 

 

 

 

 

 

 

g. Verify the Directory location, and press the “OK” button 

 

 

 

 

 

 

h. Verify “MS dBase Data Source” appears in list, and press “OK” 
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Query Exports for EXCEL 2013-Continued 
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Query Exports for EXCEL 2013-Continued 
3. Importing DBF/DBT files into Excel 2013 

a. Open Excel 2013 to a new (blank) workbook 
b. Click on the “Data” tab 

i. Click “From Other Sources” 
ii. Select “From Microsoft Query” from the menu 

 

c. Select “MS dBase Data Source” from the list 
i. Click the “OK” button 

 

d. Select the file to open from the list on the left side 
i. Press the > button to move all columns to the right side 
ii. Press the “Next” button 

 

 

 

 

 

e. Press the “Next” button 
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Query Exports for EXCEL 2013-Continued 
f. Press the “Next” button 

 
 
 
 
 
 
 
 
 
 

g. Select “Return data to Excel” 
i. Click the “Finish” button 

 

h. Defaults to “Table” & “Existing worksheet” (cell A1) 
i. Click “OK” 

 

 

 

 

 

 

 
 

i. Query data (with Legal, if included) will import into the spreadsheet 
i. Save as Excel workbook (to any location, rename if desired) 
ii. Delete the DBF and DBT files from the desktop 
iii. Open the Excel (*.xlsx) file to review/edit as needed 
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By: Terri Scheuermann 

With the recent Iowa Department of Revenue rule regarding Multi Residential and Dual Classed property there have 
been many questions and ideas of how to track them in CAMAvision.  Here is one EASY way to track those properties 
once you have identified what properties will be affected: 

If you were to make a standard note such as simply typing multi res OR dual class, those parcels can then be easily 
found by utilizing the Query Lite with Notes search. 

 

 

 

 

 
 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the right arrow key now to scroll through those parcels that have a note containing the words dual class.  Now 
how easy is that? 

 

 

 

 

 

 

Multi Res/Multi Class Easy Search 

Select Query Lite with Notes from the 
Parcel Search Screen 
 
Scroll until you find the field note. 
NOTE ~ double click to place it in the 
query then type containing ‘dual class’ 
and select OK 

The parcel list is displayed.  Select OK. 
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Minnesota 
Becker County 

City of Moorhead 
Pipestone County 

 
 

Nebraska 
Seward County 

Missouri 
Clark County 
Phelps County 

 
 

South Dakota 
Dewey County 

Walworth County 

North Dakota   
Cass County 

City of Grand Forks 
Dickey County 

Hettinger County 
LaMoure County 

Logan County 
Mandan City 
Oliver County 
Pierce County 
Slope County 

Towner County 

By: Marty Barrett 

Looking for a device that can do it all? The Lenovo Helix might be for you. 

When attached to its base the Helix looks just like a regular clamshell notebook. You can carry it around and type just 
like a normal laptop. It has a decent quality keyboard for a device of this size. Compared to some other ‘convertible’ 
devices this keyboard is much better to type on. The keyboard even includes a second battery to allow for extra life. 

 

 

 

 

 

 

 

When detached the Helix functions as a tablet. The ‘slate’ piece is fully detachable from the keyboard, allowing you to 
venture forth into the world without being weighed down by a heavy keyboard. 

 

 

 

 

 

 

CAMAvision Remote works great on this tablet. The 11.6” screen provides plenty of room for your work and it has plenty 
of horse power to run very intensive tasks. The Helix also has pen support with a pen that stores inside of the tablet (to 
prevent losing your pen).  

VCS Tech Team-Tablet Tips 
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Iowa 

Delaware County 

Ida County 

Iowa City 

Kossuth County 

Madison County 

Pocahontas County 

Illinois 

Henderson County 

Minnesota 

Blue Earth County 

Sibley County  

Missouri 

Andrew County 

Barry County 

Pettis County 

Iowa Grundy County Sac County 

Allamakee County Hamilton County Sioux City 

Benton County Hancock County  Story County 

Black Hawk County Hardin County  Tama County 

Buchanan County  Harrison County Union County 

Butler County  Henry County Warren County 

Carroll County  Howard County Washington County 

Cedar County Humboldt County Wayne County 

Chickasaw County Iowa County Webster County 

Clay County  Jackson County Winneshiek County 

Clayton County Jefferson County Woodbury County 

Clinton City Keokuk County Wright County 

Crawford County Linn County  

Dallas County Mahaska County Illinois 

Davenport City Marion County Douglas County 

Dickinson County Monroe County  

Emmett County Muscatine County Minnesota 

Fayette County O’Brien County Mower County 

Floyd County Plymouth County Nobles County 

Greene County Poweshiek County Rice County 

Iowa-October 22nd & 23rd at the Cedar Rapids Marriott Cedar Rapids 

Minnesota-October 15th & 16th at the Holiday Inn St Cloud 

Missouri-August 13th & 14th at the Stoney Creek Inn Columbia 

North Dakota-September 16th & 17th at the Comfort Inn Bismarck 

South Dakota-July 29th & 30th at the Best Western Ramkota Pierre 

At this year’s meetings we will be offering a commercial school day 2 with Bob Ehler 

http://www.camavision.com/events.php 
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Don’t forget about your bumper sticker contest for the 2014 user group meeting on your holiday travels. 
Here’s some examples of using the bumper stickers. Try to guess where Nick is at.  This is your chance 
to win $500 off the module license of your choice or serviceplus time.  All you need to do is take this VCS 
bumper sticker and have your photo taken in front something unique.   
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VANGUARD APPRAISALS,  INC.  

1065 SIERRA CT NE SUITE D 
CEDAR RAPIDS,  IA 52402 
P#319-365-8625 F#319-365-0142 
TOLL FREE 1-800-736-8625 
WWW.CAMAVISION.COM 

Since 1968, Vanguard Appraisals has been at the forefront of the mass appraisal industry.  Our trained staff 
includes specialists in field data collection, appraisal review, pricing, mass appraisal project management, 
court preparation and testimony, data entry, software engineering, technical support and training. 

Our Flagship CAMAvision product has been developed specifically to operate in the assessor’s environ-
ment.  Vanguard is a full service company.  We provide a wide range of appraisal products and services 
for assessors, we also see all the projects through completion.   

Customer satisfaction is our main goal. 
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Kelvin Santee 
Mass Appraisal Associate 

Molly Ramsey 
CAMA Specialist 

Robert Bellmer 
Mass Appraisal Associate 

Torey Scarnati 
Mass Appraisal Associate 

Welcome Welcome Welcome 
Vanguard’s Vanguard’s Vanguard’s 

Newest Newest Newest 
EmployeesEmployeesEmployees   

www.camavision.com
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